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This document explains how to upgrade a Model FC4500, FC5500, 
FC5700, or FC4700 disk-array processor enclosure (DPE) to a Model 
FC4700-2, 2-gigabit DPE. It outlines how to replace power supplies and 
storage processors (SPs), and then describes how to initialize the SPs.
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Only an authorized EMC service provider should perform the conversion 
procedure described in this document.

CAUTION!
This conversion procedure DOES NOT support the transfer of data 
between FC4500/FC5500/FC5700 systems and the FC4700-2.
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Requirements

Requirements
• The Fibre Channel SAN and attach environment must support 

the FC4700-2 prior to the conversion. Refer to the CLARiiON® 
Open Systems Support Matrix for FC4500, FC4700, FC5300, and 
FC5700.

• Your host HBA or switch environment must match the new 
array’s Fibre Channel speed before converting to an FC4700-2. You 
should set switches to autonegotiate FC speed. 

• The server host bus adapters (HBAs) and cables must support 
optical attach components. The FC4700-2 DPE is optical only. 

• The FC4700-2 requires new optical cables with LC connectors to 
replace the SC-connector cables used on previous SPs. 

• Your FC4700-2 connect topology must be either direct connect or 
fabric-switch (no hub).

• The Disk Processor Enclosure (DPE) you will upgrade must have 
two Link Control Cards (LCCs) and be connected to two Standby 
Power Supplies (SPSs). All attached DAEs must have two LCCs 
and two power supplies as well.

• All management software and host attach software must be at a 
supported revision for the FC4700-2. Refer to the Open System 
Support Matrix for these revisions.

• The Navisphere® Management Station must be running 
Navisphere revision 5.2.5 or later prior to conversion.

• Each FC4700-2 SP (2 per array) must have a TCP/IP network 
connection, and the Navisphere Management Station must be on 
this network. You will connect the SPs to this network during the 
setup procedure.

• You will need a service (usually laptop) computer with the 
following:

• Windows NT® 4.0 with Service Pack 5 or Windows® 2000

• Navisphere Manager, CLI revision 5.2.5

• Remote Access Server

• You will need a null modem cable with 9-pin, female connectors.

• You will need two .5-meter cables (P/N 118025170) per DAE for 
DAE-to-DAE connection.
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• FC4700 arrays must be running Base Software at revision 8.43xx 
or above before you begin conversion to an FC4700-2. 

IMPORTANT To preserve any data on FC4500/FC5500/FC5700 systems, 
you must back up the data prior to the conversion. After the FC4700-2 
initialization, you must perform a complete restore of the preserved data. 

FC4700-to-FC4700-2 conversions are “data in place” operations. As a 
precaution, you should always back up required data prior to any major 
procedure.

Confirm that the system you are converting contains only the 
storage-system disks shown in Table 1. If not, replace the disks with 
supported drives. 

Table 1 Disk Drives Supported in FC4700-2 Arrays

Vendor Disk (P/N) Description

Seagate 005045266 9 Gbyte, 7200 rpm

005045270 9 Gbyte, 10K rpm

005045715 9 Gbyte, 10K rpm

005045934 9 Gbyte, 10K rpm

005045268 18 Gbyte, 7200 rpm

005045272 18 Gbyte, 10K rpm

005045932 18 Gbyte, 10K rpm

005046630a

a. Only supported in DAEs using power supplies with part 
number and revisions at or above 005042633-21 or 
005045508-04

18 Gbyte, 15K rpm

005046730 18 Gbyte, 10K rpm

005045936 36 Gbyte, 10K rpm

005046732 36 Gbyte, 10K rpm

005046734 73 Gbyte, 10K rpm

005047169 73 Gbyte 10k rpm

IBM 005045713 18 Gbyte, 10K rpm

005045719 36 Gbyte, 7200 rpm
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The disk part number (005 number) appears on a label either on the 
side or the front of the plastic carrier, as shown in Figure 1.

Figure 1 Location of Part Number on Disk Drive

Upgrade Kit
The FC4700-2 Upgrade Kit contains the following:

Related Documentation
• FC4700-2 Rackmount Model Hardware Reference (P/N 014003072)

• EMC Navisphere Manager Version 5.X Administrator’s Guide 
(P/N 069001036)

• EMC Fibre Channel Storage System Model FC4700-2 Configuration 
Planning Guide (P/N 014003082)

• CLARiiON Open Systems Support Matrix for FC 4500, FC4700, 
FC5300, and FC5700 (available on MySalesWeb at home> site 
director> products> Interoperability> Matrices)

EMC2074

Label

Label

Items Part Number

2 SPs, each with 1 Gbyte of memory 005047390

2 650-W power supplies 005047396

Base Software media and documentation 005047381

EMI shield gasket kit 005047515

2 1-M Fibre Channel cables 118027372

1 cabinet cabling diagram 002055929
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Converting the Hardware

CAUTION!
The following procedure assumes any data on an 
FC4500/FC5500/FC5700 array is of no future value, because data 
will not be preserved.

Perform the following steps to convert an FC4500, FC5500, FC5700, or 
FC4700 storage system to an FC4700-2 DPE.

1. Verify that the Navisphere Management Station is running 
Navisphere Manager revision 5.2.5 or later. 

2. If you are converting an FC4700 array, verify that the FC4700 is 
running Base Software revision 8.43.xx or later, and all related 
layered drivers and applications. 

3. Power down the storage system.

4. Confirm that all drives in the array are supported by the 
FC4700-2; replace any drives not listed in Table 1 on page 3.

5. Label and disconnect all cables connected to the storage 
processors (SPs).

6. Remove the power supplies from the DPE enclosure.

Refer to Chapter 4, Servicing and Upgrading a DPE, in the FC4700-2 
Rackmount Model Hardware Reference. The power supply removal 
procedure is the same for all these systems.

7. Install the new FC4700-2 power supplies (P/N 005047396).

Refer to Chapter 4, Servicing and Upgrading a DPE, in the FC4700-2 
Rackmount Model Hardware Reference.

8. Remove the SPs from the DPE enclosure. 

Refer to Chapter 4, Servicing and Upgrading a DPE, in the FC4700-2 
Rackmount Model Hardware Reference. The SP removal procedure is 
the same for all these systems.

9. Install the new EMI shield gasket in the lower SP enclosure, as 
shown in Figure 2 and Figure 3.

a. Use needle-nose pliers to remove the EMI clips from the SP 
enclosure (see Figure 2).
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Figure 2 Removing the EMI Clips

b. Remove the paper backing from the gasket adhesive, and then 
install the EMI gasket between the lines of holes that held the 
EMI clips. Refer to Figure 3. 

Install the gasket with the adhesive strip to the rear of the machine 
(toward you). 

EMC2079

EMI
clips
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. 

Figure 3 Installing the SP Enclosure EMI Gasket

10. Install the new FC4700-2 SPs. 

Refer to Chapter 4, Servicing and Upgrading a DPE, in the FC4700-2 
Rackmount Model Hardware Reference.

11. Re-cable the DAEs using the cabling information in Figure 5 or 
Figure 6.

The upgrade kit includes the necessary SP-to-DAE cables. The 
SP-to-DAE cables are 1-m cables (P/N 118027372). The 
DAE-to-DAE cables are 0.5-m cables (P/N 118025170). These are 
not included in the kit, but should have been ordered separately.

Systems that require a second cabinet (for example, configurations with more 
than 100 disks) need a 10-meter DAE-to-DAE cable (P/N 11825172) to 
connect the buses between cabinets, as shown in Figure 6.

EMC2080

Paper
backing

Adhesive side
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12. If necessary, (re-)set the DAE Enclosure Addresses (EAs). On Bus 
0, the DPE has a fixed EA of 0, which cannot be changed. Set the 
first DAE on Bus 0 to EA 1, the next to EA 2, and so on. On Bus 1, 
set the first DAE to EA 0, the second to 1, and so on. See Figure 4, 
Figure 5, and Figure 6 as necessary.

Resetting the Enclosure Addresses is required for all upgrades other than 
FC4700 to FC4700-2. 

Bus 0 begins at the LCCs of the DPE. Bus 1 begins at the SP ports.

FC4700-2 Base Software does not recognize EAs of greater than 5 on 
either bus. This limits the total disk count to 120 drives, 60 per bus.

Refer to the EMC Fibre Channel Storage System Model FC4700-2 
Configuration Planning Guide for detailed information. 

Set the DAE enclosure address on the EA switch behind the front 
door when power is not applied to the chassis (for example, 
configuring prior to turning system power on).

CAUTION!
You should NOT change the enclosure address while the 
system is active.

Figure 4 Changing the EA on a DAE

Figure 5 and Figure 6 show sample DPE/DAE bus, enclosure 
address, and cabling configurations.

EMC2078
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Figure 5 Sample DPE and DAE Cabling in a Single-Cabinet Installation

Figure 6 shows the recommended cabling scheme for a system that 
spans two cabinets.
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Note that this configuration simplifies cabling by separating the 
busses into individual cabinets.

Figure 6 Sample DPE and DAE Cabling in a 2-Cabinet Installation
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13. Cable the SPs to the SPSs. Power up the storage system and verify 
that the status LED on the front of each SP shows normal green 
(not amber).

Figure 7 SP to SPS Cabling
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14. Connect the new LC-connector Fibre Channel cables from the 
switch or server to port 0 or port 1 on the SP as shown in Figure 8.

a. Remove the protective covers from the connectors and cables. 

b. Plug the cables into the SP host ports. 

c. Connect the other end of the Port 0 (top) cable as follows:

• For direct attach configurations — to the host server’s host 
bus adapter (HBA).

Make certain the 2-gigabit HBA is installed in the host server before 
you connect the SP.

• For Storage Area Network (SAN) configurations — to a Fibre 
Channel switch port.

d. Connect the other end of the Port 1 (bottom) cable as follows:

• On a system without MirrorView™ — to an HBA port 
(direct-attach configurations) or switch port (SAN 
configurations).

• On a system with MirrorView — to Port 1 of the 
corresponding storage processor (SP) on the remote 
storage system, or to a switch that has been properly zoned 
to the mirror port of the remote array. 

Figure 8 Reconnecting the Fibre Channel Cables

EMC2077

SP-B

SP-A

Port 0

Port 0

Port 1

Port 1



 FC4500/FC5500/FC5700/FC4700 to FC4700-2 Storage Systems Conversion Guide 13

Converting the Hardware

At the completion of the hardware conversion, each DPE chassis in your 
system should include two SPs, two SPSs, two LCCs, and two power 
supplies. Each DAE should include two LCCs and two power supplies.

Returning the 
Original SPs and 
Power Supplies 

EMC Customer Service has detailed instructions for proper return 
and accounting of the replaced storage processors and power 
supplies. Please arrange with EMC Customer Service for return of the 
FC4500, FC5500, FC5700, or FC4700 SPs and power supplies. 
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Initializing an FC4700-2 Storage System
This section explains how to set critical startup parameters on the 
FC4700-2 SPs. 

IMPORTANT If you are converting an FC4700 array to an FC4700-2 array, 
skip the initialization process and go directly to Step 48 on page 21.

PSM LUN Configuration Rules
Before beginning the initialization process, please note the following 
Persistent Storage Manager (PSM) LUN configuration rules.

• The PSM LUN must be a redundant RAID type completely 
housed in the DPE chassis.

• A RAID 1 or RAID 5 PSM LUN must have at least one drive that 
is not a database (DB) drive.

• A RAID 3 PSM LUN must have 5 or 9 drives, at least one of which 
is not a database drive.

• A 4-drive RAID 1/0 PSM LUN can use only one database drive 
when using Base Software 8.41.04.

• A 4-drive RAID 1/0 PSM LUN can use up to two database drives 
when using Base Software 8.41.09 or higher.

Database (DB) drives are the first three drives in the DPE chassis (drives 0-2).

What These Configuration Rules Disallow
The PSM LUN configuration rules disallow a:

• RAID 0 PSM LUN.

• RAID 1 PSM LUN of drives 0 and 1.

• RAID 1 PSM LUN of drives 1 and 2.

• RAID 1 PSM LUN of drives 0 and 2.

• 3-drive RAID 3 PSM LUN of drives 0 through 2.

• 3-drive RAID 5 PSM LUN of drives 0 through 2.

• 4-drive RAID 1/0 PSM LUN where two or three of the drives are 
DB drives, Base Software 8.41.04.
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• 4-drive RAID 1/0 PSM LUN where all three of the DB drives are 
used, Base Software 8.41.09 or higher.

PSM LUN Placement The following rules apply to PSM LUN placement:

• The PSM LUN can be on a RAID group with other LUNS.

• THE PSM LUN should be considered a “high use” LUN during 
the planning for LUN distribution across RAID groups/disk 
drives.

• As with any other “high use” LUN, the PSM LUN should share 
disk drives (RAID groups) with other LUNs that will not heavily 
compete with each other for I/O access to the drives.

• You should distribute high and low use LUNs across RAID 
groups, and balance the load.

By default, Navisphere Manager automatically selects drives 2-6 in the 
DPE chassis group and creates a RAID 5 PSM LUN in that group. To 
create a PSM LUN on other drives in the array, select Support RAID 
Type in the PSM Admin Bind LUN dialog box.

Initializing the Storage System
Follow the steps below to initialize the FC4700-2 storage system.

1. Set up the service laptop as described in Chapter 3 of the 
FC4700-2 Rackmount Model Hardware Reference. Make certain it 
includes Navisphere Manager revision 5.2.5 or higher.

2. On the service laptop, follow the path:

Start→ Programs→ Admin Tools→ User Manager

The User Manager dialog box opens.

3. From the User menu, select New User.

4. Create a new user account called clariion1992, with the password 
clariion1992.

You must fill in the Confirm Password field. 

5. Check the Password Never Expires box.

6. Click Groups.

The Group Memberships dialog box appears.
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7. Assign this account dial-in and administrator privileges.

8. Click OK.

9. Click Dial-in.

The Dial-in dialog box appears.

10. Check the Grant dial-in permission to user box.

11. Click OK.

12. Modify the laptop’s TCP/IP network settings to use DHCP as 
follows:

a. Right-click Network Neighborhood, and then select 
Properties.

b. Click the Protocols tab.

c. Select TCPIP, and then click Properties.

d. Note your current settings so that you can restore them later.

e. Click Obtain an IP address from DHCP Server, and when 
prompted for confirmation, click Yes.

f. Click OK.

g. In the Network dialog box, click OK.

h. When prompted to reboot, click Yes.

13.  Unplug any network connections to the laptop.

14. Log in to the laptop as user clariion1992 with the password 
clariion1992.

15. Connect the null modem cable between the laptop (port COM 1) 
and the SP-A service port COM 1, as shown in Figure 9.
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Figure 9 SP COM 1 Port

16. On the laptop, follow the menu path My Computer → Dial-up 
Networking.

17. Select the phonebook entry you created when you set up the 
laptop in the previous section.

18. Click Dial.

19. In the Connect to dialog box, log in as user clariion with 
password clariion!. Ignore the Domain field.

20.  Click OK.

21. Start Navisphere Manager.

22. Follow the menu path File → Select Agents, and in the Agent to 
Add field specify the SP’s IP address, which is 192.168.1.1.

23. Click the arrow next to the IP address to add the SP to the 
Managed Host field.

24. Click OK.

25. Click OK in the Storage System Management Warning dialog.

26. Verify that you have read the PSM LUN restrictions on page 14 
before proceeding.
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27. Create a PSM LUN as follows:

a. Right-click the storage system on which you want to create a 
PSM LUN.

b. Select Initialize Array.

The PSM Admin Bind LUN dialog box opens.

c. Specify a valid RAID type that the customer wants (for 
example, RAID 5) and specify the disks for the PSM LUN.

See "PSM LUN Configuration Rules" on page 14.

d. Click OK.

e. The PSM Admin Bind LUN dialog box appears. Click Yes, 
then click OK.

Wait for the PSM LUN bind to complete.

28. Use the following command to set the chassis/array serial 
number:

navicli  -h 192.168.1.1 arraysernum -messner <serialnumber>

The serial number can be found on a sticker on the top of the DPE 
chassis. It is the letter F, followed by eleven (11) digits.

29. Next you must specify Privileged Users for the storage system. 
You can do this using CLI or Navisphere Manager. If you are 
using Navisphere Manager, skip to Step 30. 

The list should include every person who will administer the 
storage system (including the login for the laptop). 

Use the form username@hostname; for example, admin@pc1234. At 
least one hostname must match the Navisphere Management 
Station hostname.

CAUTION!
If a privileged user is not specified during initial setup of the 
storage system, anyone can manage that storage system.

a. Bring up a DOS command prompt by following the menu 
path Start → Programs → Command Prompt or Start→ Run 
→ cmd.
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b. Go to the directory containing the navicli files by entering:

c:\program files\emc\Navisphere cli 

c. Use the following command to add each privileged user:

navicli  -h 192.168.1.1 remoteconfig -setconfig 
-adduser username@hostname 

d. When the CLI prompts for confirmation, answer Y for yes.

e. Repeat step 29c for each privileged user you want to add.

30. To specify Privileged Users in Navisphere Manager, perform the 
following procedures.

The list should include every person who will administer the 
storage system (including the login for the laptop). 

Use the form username@hostname; for example, admin@pc1234. At 
least one hostname must match the Navisphere Management 
Station hostname.

a. In the Enterprise Storage dialog box, click the Storage tab.

b. Click the storage system for which you want to display the 
SPs.

c. Right-click the icon for the SP (A or B) to which you want to 
add privileged users, then click Properties.

d. Click the SP Properties - Agent tab.

e. Under Privileged Users, click a blank line.

f. In the text box that appears, type the name of the privileged 
user.

g. Click Apply in the Agent tab to save your changes. Click OK 
to save your changes and close the SP Properties dialog box.

31. Use the following CLI command to set the cache defaults:

navicli  -h 192.168.1.1 setcache -wc 1 -p 8 -L 80 -h 96

32. Answer Y to confirm.

The SPs will reboot two times.

33. Repeat steps 15 through 19 to reconnect to SP-A and start 
Navisphere Manager.

34. In the SPS Properties dialog box, set the SPS test.
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35. Click OK.

36. From the Array Properties dialog box under the General tab, 
confirm the chassis ID is valid.

37. Using the Network tab in the SP Properties dialog box, specify 
the SP-A hostname, IP address, subnetmask, and gateway 
address. 

The customer will provide you with the names desired for the 
SP-A hostname and the correct subnetmask and gateway address.

38. From the General tab, set the date and time for SP-A.

39. Click OK. You will be asked to confirm your changes. Ensure that 
the settings are correct, then click Yes twice.

SP-A reboots.

40. Connect the laptop COM 1 port to the SP-B COM 1 port using the 
NULL cable.

41. Establish a PPP connection to SP-B using steps 15 through 19 in 
this section.

42. Use Navisphere Manager’s Network tab in the SP Properties 
dialog box to specify the SP-B network information as in steps 37 
and 38. You will be asked to confirm your changes. Ensure that 
the settings are correct, then click Yes twice.

SP-B reboots.

43. Connect the LAN cables to the SP for Navisphere management as 
shown in Figure 10. 

Figure 10 Connecting the LAN cable
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44. Log in or have the customer log in to a Navisphere Management 
station connected to an FC4700-2.

45. Use Navisphere Manager to manage both SP agents as follows:

a. Follow the menu path File → Select Agents. 

b. In the Agents to Add field, specify the SPs’ IP addresses that 
the customer provided in steps 37 and 42 above.

46. Using the ALPA tab in the SP Properties dialog box, set the ALPA 
SCSI ID value for each port of SP-A and SP-B.

The SP reboots after each ALPA you set.

47. If you need to set the SCSI ID of another SP port, repeat step 46.

Set the Desired FC
Speed for Each Port

on SP-A and SP-B

48. Using the Fibre Speed tab on the SP properties dialog box, 
change the fibre speed for each SP port as follows:

Note: You may set the ports on an SP to operate at different speeds.

a. In the Enterprise Storage dialog box, click the Storage tab.

b. Double-click the icon for the storage system component and 
then right-click the SP component for which you want to set 
the SP port speed.

c. Click Properties, then click the Fibre Speed tab.

d. Under Current Settings, select the speed for each port.

e. Click Apply or OK to save the changes.

f. If an SP is connected directly to a host bus adapter (HBA), 
refer to the HBA documentation.

49. Confirm that both SPs are running the latest Base software.

50. Make certain all software packages are committed. 

a. In Navisphere Manager, check the Software tab of the Array 
Properties selection for any software packages requiring a 
COMMIT. 

b. Perform the commit if necessary.

51. Install any layered software, such as SnapView™ or MirrorView. 
For further information, refer to the Navisphere Manager 
Administrator’s Guide.
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IMPORTANT If you are converting an FC4500, FC5500, or FC5700 system 
to an FC4700-2, you must install Access Logix before the SnapView or 
MirrorView software. 

You have initialized an FC4700-2 storage system. The next step is for 
the customer to set up a Navisphere Management Station. If possible, 
keep the service laptop handy until the management connections 
have been tested.
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